
         Digital Camera 101 
 
 
 
Objective 
 
Have you taken that perfect picture, but have no idea how to get it from the 
camera to the computer?  In this two-part class several types of digital 
cameras will be explored along with the opportunity to customize and e-mail 
a digital picture file on the computer. 
 
 
Course Overview 
 
 
The Basics Resizing and Cropping Images

Resolution of Photos Color and Contrast

Downloading Images Email

Digital Photo Management Sharing Photos

Resizing images Creative Things to do Using 
Photoshop Elements

Photoshop Elements Work 
Area

Turn Your Photo into a Piece of 
Art

Saving A File  



 
   Digital Camera 101 

 
 

 
 

 
 
 
 
 
the Basics 
 
So you have a digital camera and want to know how to use it. Great! This class will 
teach you the basics of how digital cameras operate so you can get the most out of the 
camera you have, impress your friends and enjoy your new digital photos.  To do that, 
we have to get down to basics. 
 
 
Pixels 

A pixel is a tiny square of color, 
thousands of which make up your 
photo, much like a mosaic. A 
megapixel is the term for one million 
pixels. Digital cameras are referred to 
according to the maximum number of 
magapixels they are capable of taking 
in a single photo file.  
 
dpi is the term for dots per inch, referring to how many 
dots or pixels per inch you have in a digital file. Your 
printer has a specific number of dots per inch it can print. 
It is also used to describe the resolution of your 
computer screen and the preview screen on the back of 
your camera.  
 

jpeg is a type of photo file most commonly created by digital cameras. It is named for 
the Joint Photographic Experts Group which named it. Photos on the web are most 
often saved in this format. Jpegs are compressed, making the smaller and easier to put 
more on a memory card or send via email. 
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RAW is a photo file format offered as an option in some cameras. RAW files are not 
compressed so they are large. 
 
Memory Cards   
 

When you take a photo, the camera writes the digital 
information or file onto a portable hard drive called a 
memory card. These cards come in various sizes, shapes 
and capacities. The card is removable and can be cleared 
to be reused thousands of times. Your camera card can be 

used to transfer image files to your computer, a 
photo kiosk, a photo printer or simply for            
short term storage.  

 
Each camera takes a specific type of card. 
Compactflash, Memory Stick, Secure Digtial 

and xD—picture Card are the most common types of memory cards 
used in today’s digital cameras. Each one comes in a variety of capacities such as 512 
MB, 1 GB, 2GB or more. Some, such as compact flash cards, are available in a model 
that is faster than the regular card. This type of card is great for camera taking 6 – 10 
MB images and for when you are shooting a quick series of photos so the camera can 
write the information on the card more quickly and not prevent you from taking your next 
photo because the camera is processing the previous ones. 

           
Your camera’s bells and whistles 
 
Cameras like cars vary in the number of options from one model to the next. The 
smaller cameras have a tendency to have fewer options because there is less room for 
the buttons and knobs. The size of the LCD screen on the back varies and some are 
movable. A few models have so little room that they don’t have a view finder other and 
must use the LCD screen instead.  
 
Here are some basic and not so basic features on most digital cameras: 

 
LCD screen – With this screen on the back of your 
camera, you can review your photos after you take them so 
you know which photos you want to keep and delete bad 
shots. This screen can for a viewfinder and sometimes on 
small cameras is the only viewfinder. This screen is also 
used for making choices in your menu for setup of your 
camera’s options.  
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Basic Shooting or exposure Modes – All cameras come with options for 
choosing the correct exposure for your photos. These exposure or shooting modes are 
chosen by selecting them on a dial on the top or back of your camera. You chose the 
type of mode you want by turning the dial to the icon or letter representing that mode.   



 
 
 
Cameras have a standard mode with autofocus so you simply 
point the camera at the subject and press the shutter button.  

In the example of a camera above, you would choose AUTO. Cameras with more 
features may also give you the option of setting your camera’s ISO and shutter speed 
manually too. 
 
Digital cameras typically come with these basic shooting modes:  
 

• Automatic - In this mode (usually is listed on the dial or screen as Auto), the 
camera is operating like a point and shoot camera.  It automatically focuses, 
chooses the shutter speed, and the aperture setting for light.  

• Landscape  – This mode should be selected for a photo with overall focus 
• Portrait – Choose this mode for a 

photo with focus on the closest object 
• Sports or action - This mode is great 

for athletic competitions, kids playing, 
etc. 

• Macro – This mode is used for close-
ups within about two feet or less, 
depending upon the camera’s 
capabilities.  

• Program – The program mode (usually 
listed as P) is a modified automatic 
mode. You are allowed to select the 

aperture and shutter speed in the menu or other procedure depending upon the 
camera. Once that is set, you can choose this mode for your special needs.                                

• Shutter priority – Shutter priority (usually listed as S) allows you to set the 
shutter speed and the camera will choose the appropriate aperture and will still 
automatically focus for you. This feature is good if you are shooting a sports 
event and want a stop action photo by shooting at high speed or want to slow the 
camera’s shutter down so you can blur an action. 

• Aperture priority - Aperture priority (usually listed as A) allows you to dial the 
aperture setting you want for the type of photo you are taking and the camera will 
adjust the shutter speed as well as the focus for you. This is ideal for a photo 
where you want a specific depth of field.  

• Manual - Manual (usually listed as M) is for people who love the non-automatic 
cameras like the old 35mm cameras and who want to set the shutter priority and 
aperture themselves. This is a great option if you like to do long exposures. 
 

Special shooting modes 
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There are cameras on the market which can give you many more shooting options in 
addition to those listed above. You need to think about the kind of photos you want to 
take and how much money you want to spend on a camera. The more options you 



choose, the more the camera will cost. Here are some examples: 
 

• Red-eye reduction – Many cameras offer a red-eye reduction option which will 
set the camera’s shutter to automatically avoid situations where eyes will turn red 
when the camera’s flash goes off by sending a pre-flash to make the subject’s 
pupils get smaller before the main flash goes off.  

• Panorama – This mode gives you either one very wide photo or allows you to 
stitch together several photos taken in sequence of a wide area. There has to be 
some overlap from one photo to the next so the photos can be meshed together 
to create a panoramic shot. It is helpful to use a tripod when taking these photos 
to keep your camera at the same place horizontally when taking the series of 
photos. 

• black and white – This mode lets you shoot you photos in black and white, 
simulating black and white film. If you have software like Photoshop Elements, 
you can convert a color photo to black and white, giving you two options for one 
photo.  

• sepia tone – If you like old photos in black, 
white and sepia tones, this would be a fun 
option for you new camera. 

• custom color modes allows you to setup 
your camera with special color choices so 
skin tones, unusual lighting, etc. will not be 
corrected by the camera giving you an image 
that is true to what you see through the lens. 

• fireworks or night scenes – If you enjoy night photography of cityscapes, 
fireworks, or any other scene with high contrast of light vs. dark, this is a good 
option to look. 

• snow or beach mode for very bright backgrounds.  
 
 
Video mode: This varies from camera to 
camera. Some shoot short video and a few will 
shoot video for up to an hour, according to the 
maximum space available on your memory 
card. Not all have sound capability. 
 
 
 

Photo enhancement: Certain models give you the 
option of cropping and removing red-eye while your 
photos are still on your camera card and thus control of 
these options take place using the LCD  screen. 
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PictBridge Technology  PictBridge is a 
standardized technology found on many cameras which 
allows you to print from your camera to a printer without the aid of a computer.  You 



must have a printer that is PictBridge compatible.  The feature is more common on 
small photo printers such as the Epson Picturemate 
(see printers). Once a PictBridge digital camera is 
connected to the proper printer, print options appear 
on the camera monitor (LCD). The camera menu 
system is used to make settings such as print size, 
layout, media type and date. Sometimes the 
compatible printer will have its own LCD screen so you 
can make your choices using the printer screen and 
buttons instead. 
 
 
Optical Zoom vs. Digital Zoom 

Optical zoom is similar to what you'll find in a regular 35mm 
camera: When you push the button to zoom in or out, physical 
lens elements move inside the camera, to achieve the desired 
effect. Digital zoom has no moving parts. Using the processor 
inside the camera instead, the camera focuses on the object or 
objects already zoomed in on and digitally zooms in even more. 

The average digital camera has the ability to zoom in 3 or 4 times more than the 
maximum of the optical zoom. 

The problem with digital zoom is that you lose quality when you do this -- your images 
will tend to be more "pixelated" than the same image taken with an optical zoom 
camera. This is due to the "interpolation" the camera uses, which is a nice way of 
saying that it makes a guess about how the picture should look while zoomed in. Having 
optical AND digital zoom on a camera isn't bad, but I'd try to avoid cameras with only 
digital zoom, myself. 

Kodak has come out with a new camera with two 
separate lenses you can switch between depending 
upon your needs. One is a macro or close-lens and 
the other is a standard lens with limited zoom. It’s 
an interesting solution for people who like to do 
close-ups but prefer a small camera. 

Batteries  
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In the majority of cameras, the battery or batteries that fit your camera were made 
specifically for that model. Buy a second battery or set of batteries to have as a backup. 
As a rule, a battery charger comes with your camera. Digital cameras are capable of 
using a great deal of power and, depending upon how you use yours, having a fully 
charged second battery is a wise thing to do. 



Some cameras take AA batteries, which can be to your advantage for several reasons. 
You can buy NiMH (Nickel Metal Hydride) rechargeable batteries and a charger, which 
is cost effective. Despite the fact they are more expensive to purchase, rechargeable 
batteries can be used and recharged hundreds of times. If you are on a trip and your 
batteries die, then you can pick up some ordinary alkaline AA batteries in nearby store. 
As a rule, avoid using disposable AA batteries because your camera will use them up 
quickly.  

You can get the most out of your camera’s battery by using power wisely. Here are 
some ideas: 

• Many cameras give you the option of turning off or going into a sleep mode 
automatically after so many minutes of not being used.  

• Your LCD screen on the back of the camera takes a great deal of power. If you 
have the option, turn off your LCD screen and use your optical view finder to aim 
your camera while taking photos.  

• If you are taking many, many photos, wait to review all of them after you 
download them on your computer.  

• Be aware that your flash also takes a lot of power so be aware that if you are 
planning to doing a great deal of flash photography, it is best to keep an extra 
charged battery on hand. 

• Use a card reader to transfer your photo files from your camera card to your 
computer or printer. Hooking up your camera to your computer or printer via fire 
wire or a dock to transfer files requires you have your camera on, which uses up 
battery life. It can also be a much slower process. 

Separate Lenses 

  If you have chosen a digital SLR camera 
body, then you have many options for 
zoom. If you had a 35mm SLR camera in 
the past, you know that the mount for the 
lens must match the body of the camera 
because the lenses are made specifically 
for certain brands of cameras. The same is 
true today with a digital SLR.  

Another consideration for 35mm lenses is technical compatibility. For example, an older 
Canon lens will have the right lens mount for a Canon 30D body but you must check to 
make sure it is an EF lens which can work with the body’s focusing system. 
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Buy the lens or lenses that best suit your needs. A 55 – 
200mm lens with that will give you ample ability to zoom 
in on subjects. If you much prefer taking close-ups or 
portraits, perhaps a 17 – 85mm zoom lens would work 



better for you. 

When buying a lens for a digital SLR, remember because you have a digital camera 
body the lens’s capability will be amplified. A Canon digital SLR attached to a 50mm 
lens will change it’s capability by 1.6. Nikon digital SLRs will change the zoom power of 
a lens by two times. Also consider one with image stabilization which will assist the 
camera with producing a crisp image. 

Add-on lenses  
There are digital cameras with built in lenses which accept add-on lenses to expand 
their capabilities to zoom as well as take wide angle and close-up photos. Kodak has 
almost a dozen models which accept these add-on lenses. There are also lens adapters 
for other models which screw onto the camera’s lens so the add-on lens can be 

attached.  
 
On the left is a .7X wide angle 55mm lens. 
When attached to the lens of the camera, it 
will increase the angle of view thirty percent.  
 
The add-on lens on the right is a telephoto 
lens for certain Kodak camera models with 

55mm built-in lenses. When attached to a compatible model’s lens, it will allow the 
camera to zoom in 1.4 times more.    
 
Resolution of the photos you are taking 
 

Every camera has a maximum number of megapixels it can produce 
when recording a photo file.  That’s why cameras are referred to as 
a 6, 7 or 8 megapixel camera.  Your camera will take photos in 
various sizes such as small, medium, large and maximum. 
Depending upon the capability of your camera, the sizes could be 

equal to 640 x 480 pixels for a small 
or low resolution photo; 1600 x 1200 
pixels for a medium photo, 2048 x 
1636 pixels for a large photo file. You 
set the size of the photo in the 
camera’s menu. 
 
Larger photo files are good for 
printing 5” x 7” or 8”x10” photos. A 
medium sized file will print a nice 
4”x6” photo. The larger the file size 
the more pixels you have to play with if you want to alter the photo by cropping. You can 
cut down or crop a large file and still have enough pixels to print a good 4” x 6” photo. 
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Downloading images 
 
There are two ways to get the photos from the camera to your computer.  
• One: you can connect your camera to your computer via a cable which came with 

the camera. The cable plugs into the camera and into a USB port on the back or 
front of your computer, depending on the computer. 

• Two: Take the camera’s memory card and insert it in a media 
reader connected to your computer.   

 
Before we move on, lets talk about 
media card readers. These inexpensive 
accessories can save you a great deal 
of time and are easy to use. They 
connect to your computer either in the back or in the front, 
depending upon your machine.  Most come with a variety of 
slot sizes so as many as twelve different types and sizes of 
media cards will fit in them. These readers usually cost less 
than $30 and can be found in many stores including office 
supply stores, electronics stores, etc. 

 
If you’re using a Mac, iPhoto 
may pop up and automatically 
copy the photos for you.  If not, 
once you’re done, another 
drive should show up on your 
computer’s desktop. Double 
click this drive to open it and 
you’ll find a DCIM directory on 
the camera card which actually 

contains your photos. 
 

 
Double click that DCIM folder as well.   
 
When putting digital photos onto a Windows based computer, a Device Detected 
options box may pop up after you either put a memory card in the card reader or 
connect your camera to the computer via 
a cable. 

• Select either  
o Organize and edit 

using Adobe 
Photoshop Elements 
or  
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o Copy pictures to a 
folder on my 
computer.   



 
If you decide to use Photoshop Elements to organize your photos, click OK and 
Photoshop Elements Organizer will open. Organizer helps you create collections of 
photos so you can find them easily.  

• In the Organizer window, click on the 
camera icon below the menu bar. From the 
dropdown menu, select downloading from 
the camera or card reader. 

• Click Get Photos.  
• Next choose a folder on your hard drive in 

which to download your photos and press 
OK. It will take a few minutes to download 
your files, depending on the number and 
size of the images you are downloading. 

 
 
 
    
 

  
                                   

 
Now you see a list of your photos.  
 
Copy these to whatever folder you 
like on your computer.  On a Mac, 
you could add them to your Pictures 
directory if you like. 
 
 
 
 
 
 
 
 
Here I’ve selected the Pictures directory and 
created a new folder for my pictures.  
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Digital Photo management 
 
Because taking digital photos can be an easy process, you may find you have taken 
many more photos digitally than you used to take using film. How will you manage to 
keep track of all of these photos? One solution as we mentioned earlier is to put them in 
file folders on your computer’s hard drive. Another possible solution is to use digital 
photo management software. This kind of software can make it very easy to sort your 
photos and find specific photos quickly without having to remember the name of the file. 
 
Photoshop Elements 4.0 has an option for doing just that. It has an Organizer which will 
allow you to browse through your photo files according to name, date, or key words 
which you can attach to each file. There are other pieces of software on the market that 
can do similar functions. We’ll use Photoshop Elements 4.0 as an example.  
 
Until now you have been working in the Editing portion of Photoshop Elements. You will 
notice that on the top of your work area you will find buttons called Photo Browser and 
Date View. These are two ways of viewing the photos you have been working on in the 
editing mode. If you click on the Date View button, the page on your desktop will change 
completely to one similar to the example below. You also have the option of using the 
Photo Browser button which takes you to the page with thumbnails of all of the images 
with options for sorting them. When you want to edit your images again, simply press 
the Edit button.  
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In the Calendar View, you search according to specific date. You change the month 
using the arrow buttons on either side of the month or by selecting a specific date on the 
calendar. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
In the Browser View, you will find near the top of the page you will find a calendar slide 
which is one of your sorting options. The blue square slides so you can find the month 
and year your files were originally created. Wherever there is a marker in the white area 
of the slide, there are photos from that time period. When you stop moving the slide, 
thumbnails of photos from that time frame will appear on the page.  
 
 
 
 
Adding Tags for easy sorting 
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You can also sort your photos after adding tags to them or by putting them in 
collections. On the right side of your screen you will see a column with a list of key 
words including Favorites, People, Places and Events. You can add any of these tags to 
your photo so you can quickly find them. You also have the option of creating tags of 
your own and keeping them under specific categories for more specific searches.  



For example, in the category of Places I’ve created a tag called Lake 
Michigan. I then added that tag to all of my summer vacation photos 
taken along the Lake Michigan shoreline so I could find only that portion 
of my summer vacation photos quickly. These photos also have a tag 
called vacation. You can add as many tags to a single photo as you want. 
 
In addition, you can add stars to your photo files to indicate which are 
your favorites or the best photos in a group. This is very handy if you 
want to send several photos that best represent an event to a friend or 
family member.  
 
Adding a tag to a photo is simple. Right click on the thumbnail of the 
photo. A box will pop up. Scroll down the box until you see Attach tag. To 
the right of Attach Tag another box will appear with tags choices listed. 
Click on one of the tags and a small icon will appear on the bottom right 
corner of your thumbnail indicating it now has a tag. You may select more 
than one image at a time and add the same tag to all of them at once. Simply hold down 
the Shift Key while clicking on the images and then add the tag.  
 
Adding photos to the Organizer    
 

To add photos you have not edited 
yet to your Photoshop Elements 
Organizer, choose File > Get 
Photos > and select the source 
where the files are currently 
stored.  Thumbnails of the new 
images will appear on the page 
ready for you to reorganize or edit.  
 
If you want to edit a new image in 
the Organizer, click on it and press 
the Edit button on the top of the 
page. Here Photoshop Elements 
will let you either do a quick edit or 
go to the page with all of your 

iting options. ed
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Resizing images 
 
Now that your photos are in the folder in your computer, let’s open Photoshop Elements 
and work on one of the pictures.  Go to File and from the dropdown menu, choose 
Open. 
 

The Open dialogue box will 
appear. Find the folder in your 
computer which contains the image 
you want to view. Select the file and 
press the Open button.  

 
 

 
The Open dialogue box will appear. Find 
the folder in your computer which contains 
the image you want to view. Select the file 
and press the Open button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The photo you have chosen will 
appear in the work area of your 
Photoshop Elements screen. Now 
you can edit, rename or simply 
get a more detailed view of the 
photo you took. 
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Becoming familiar with the Photoshop Elements 
work area 
 
When you open Photoshop Elements 4, you will find six important areas that you will 
need to be familiar with both in class and when using Photoshop Elements at home. 
 

 
 
 

Across the top of your page you will see a list running from left to right. This is called the 
Menu Bar. This bar contains menus for performing tasks. The menus are organized by 
topic such as files, editing, enhancing images, etc. When you click on one of these 
topics, a drop-down menu will appear so you can choose options related to that topic. 
For instance, when you click on File, the drop down menu that appears contains options 
such as open, save, save as, etc. for working with files.  
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Below the Menu Bar is the Shortcuts Bar. This bar contains buttons you can press 
instead of going through the menu bar to execute commands such as save, open a file, 
create a new file, undo, etc.  You can also find these options by going to the Menu Bar 



and then to a specific title but this is a faster way to do the same thing.  For example, to 
save a change in our file, you can either press the save button on the Shortcuts Bar or 
go to File and from the dropdown menu choose save. 
 

 
 
The Options Bar is below the Shortcuts bar. This bar contains options for using which 
ever tool you have selected for working on your photo. Each tool has a different set of 
options on this bar.  
 

 
 
 
The Active Image Area is the part of the screen where you image will be when you are 
working on it. It is immediately below the Options Bar. You can have several images 
open in this area at the same time. 
 
The Tool box contains tools for editing, selecting and viewing your images as well as 

tools fro painting, drawing, and creating type.  It is on the left side of your 
screen. It can be moved to other parts of the active image area is needed. In the 
tool box you will find the Marquee tool, the lasso, the magic wand, a cropping 
tool, custom shape tool, etc. Any tool icon that has a triangle in the corner of 
that box has additional tools underneath it. You can access them by clicking on 
the triangle.  
 
 
The Palette Bin is located in the upper right 
corner of your screen. It contains the How To, 
Styles and Effects, and Layers palettes. The How 
To section gives you helpful hints on how to 
complete many tasks and creative things to do 
with your images. Pallettes help you modify 
images and the Palette Bin helps you organize the 
eight palettes that Photoshop Elements offers you. 
One of the palettes is a Navigator window for 
enlarging and shrinking the image inside the work 
area. There is also a color palette for changing the 

color of selected portions of your image, type, etc.   
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Saving a file 
 
When you’re done working on your image, you need to save it. It is best not to save 
changes to the original file. Give the updated file a new name or add a number, letter, 
etc. to the original name so you know it has been altered.   
 
There are a couple of things to talk about first.  If you’re sure you aren’t going to do any 
more editing of this photograph, you can save to a JPEG format which can be easily 
placed on a web page or email.  This provides a high level of compression to make sure 
your picture takes a small amount of space.  Unfortunately, this compression also 
introduces some artifacts that you normally can’t see, but if you were to edit and save 
and edit and save several times in the JPEG format, you would eventually see very 
large blurring and blocking in your photos.  So if you know you’re going to be working on 
this photograph some more, please choose the PSD (PhotoShop Document) format, 
which takes a lot of space, but makes a perfect copy with extra information that makes it 
easier to work with the advanced features of Photoshop and Photoshop Elements. 

 
 

To save a file, go to File on the 
menu bar and from the drop down 
menu, choose Save As. The Save 
As dialogue box will appear and 
give you a choice of places on your 
hard drive to save this file. Go to the 
box near the bottom of the box and 
type a new or altered name for 
your image.  Now choose the type 
of file you want the file saved as 
from the drop down menu.  

 
 

Press Save.  
 
Another window will appear with settings for 
the quality of the image. You can choose 
small, medium, large or maximum from the 
drop-down menu or use the slider to choose 1 
to 10 for file quality. Staying the medium 
range is safe unless you are working with an 
image that will be printed at 8” x 10” or larger. 
Then it can be saved at a higher quality.  
 
 
Press Save.      
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Resizing Images 
 
In the drop-down menu under Image, choose 
Resize. 
 
Within the Resize menu choose Image Size.  The 
Image Size dialogue box will appear. In this box 
you can change the size of your image using 
different kinds of measurements such as inches, 
pixels, and points. As long as the Resample Image 
box is checked at the bottom of the window, the 
image will remain in proportion when you change 
one of the dimensions. The standard number of 
pixels or dots per inch for web images is 72. Color 
ink jet printers will need at least 150 dots per inch. High resolution images printed on 
photo printers will require a resolution between 150 and 300 dots per inch. When you 
have adjusted the size of the image to fit your needs, press OK.                              
 
Tools 
 
On the left side of your screen, you will find a box with tools used for selecting, editing 
and viewing your images as well as painting, drawing, and creating type. When you 
place your curser over one of these tools, a text box will pop up giving you the name of 
the tool. This is called a tool tip. There are additional tools hidden behind the tools that 
have a triangle in the lower right hand corner of the square the tool is in. 
 
Cropping an image 
 
Cropping is the process of selecting a portion of an image you like and deleting the part 
you don’t want to keep.  
 

• To crop an image, choose the Marquee Tool from the tool box and click on it. 
Note that there is a square 
marquee tool and an elliptical 
marquee tool. Let’s start with 
the square one. Your curser 
is now the Marquee tool.  
 

• Place your curser in the upper left corner of the area you want to keep and press 
down on your mouse button.  
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• Drag the curser diagonally across the area until you have framed the part of the 
photo you want to keep.    
 

• Release your mouse button. There should be a moving rectangle or marquee 
surrounding the section you have selected. You can move 
the marquee to another place on the photo by putting your 
curser on it and moving it using your mouse. If you want 
to make the marquee larger or smaller, place your curser 
outside of the box and click. This will cancel the marquee 
box and you can make the marquee again at the new 
size. 
 

• Choose Image and from the drop down menu choose 
Crop. The area outside the marquee now will disappear 
leaving your newly cropped image. 
 

• To enlarge the newly cropped image, select the zoom tool. Your curser 
will turn into a magnifying glass. When you click on the image with your 
mouse, it will enlarge.  

 
 
When the zoom tool is selected, the Options Bar will have a picture of the zoom 
tool in the left corner. You can magnify the image using the bar the following 
ways: 
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o Click on the magnifying glass with the + for magnifying and – for reducing 
the image. 



o The Zoom percentage box can be used two ways: type in the percentage 
number you want the image to be shown or press the arrow and a slide 
will appear which you can adjust for the percentage. 

o If you press the Actual Pixels button, then the image will appear on your 
screen at its actual size.  

o Fit Screen will make the image fit inside the available work area. 
o Print Size will show you the image at the size it will be when printed. 

 
• If you are happy with the image and have no further changes, then save it with a 

new name or the original name plus a number or other indication that this is a 
changed file (File > Save as).  
 
 

Color and contrast 
 
One of the many options given to digital camera owners is the ability to correct color, 
contrast, and red eye (eyes that appear red in your photos after using a flash to take 
your photo). Here are some ways to correct those problems or simply to adjust photos 
that you aren’t quite satisfied with. 
 
In the drop-down menu under Enhance you will find a number of easy options for 
making corrections to your photos. Auto Smart Fix automatically adjusts the whole 
color balance of the photograph and enhances details in the shadows and highlights of 
your photograph.  It’s a good place to start with working on your photos. Choose Auto 
Smart Fix and see if you like the change it makes to your photo. If you don’t like the 
change, either choose the Back button on your tool bar (below File) or choose Edit 
and Undo. 
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Other choices for 
simple adjustments 
under Enhance include 
Auto Levels, Auto 
Contrast, Auto Color 
Correction, and Auto 
Red Eye Fix. Like Auto 
Smart Fix, you simply 
choose the 
enhancement option 
and the software 
decides how much or 
little to enhance your 
photo. If you want to have some control over the changes being made, then try Adjust 
Smart Fix, Adjust Lighting or Adjust Color. Each option gives you a before and after 
view of the image so you can see how much change there will be to your photo. 



Email 
  
It’s advisable to make smaller versions of the photos you want to email and 
rename them. Sending a photo in its original size could mean you are sending an 
image that is two or three times larger than your computer monitor and would be difficult 
to view. The person receiving your email would have to scroll back and forth several 
times to try to view the entire image.   
 
Also, the original image most likely is a large file. It will take a very long time and receive 
via email unless you and your recipient have a high speed internet connection. So, 
reducing your image in size to reduce the file is also a very good idea. Also, a large 
email attachment may be too big for your friend’s mailbox and your email may bounce 
back. 
 
Rename the image after it’s been reduced in size for emailing purposes. Never 
alter your original image and save over it! You can not go back after saving! 
 
 
An average computer monitor is 800 pixels wide and 600 pixels 
high so resize your image to fit in that space. Open your 
original photo. Go to Image > Resize > Image size. This box 
will come up. Make sure the boxes at the bottom for Constrain 
Proportions and Resample Image are checked.  You can see 
under Document Size that the image is currently over 48” wide 
and 32” high.  
 
In the Pixel Dimensions section in the Width box, type 800. 
Now the dimensions of the image change but stay in proportion 
so the photo won’t be distorted.  
 
Now your image is 800 pixels wide and 533 pixels tall. It should 
fit on a computer screen at actual size without a problem. Click 
Okay.  

 
Now save the image with a new 
name. Go to File > Save As and in 
the box rename the file in whatever 
way is best for you to remember what 
the image is and that it’s smaller than the original. 
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Next the Jpeg Options box will appear.  In the Quality box, 
choose a mid-range number such as 5 or 6.  For Format Options 
make sure you’ve checked Baseline. In the Size box, you can 
check to see how long it will take to send this image as an email 
attachment depending upon your internet connection.  You can 
see in the first example, this attachment will take half a second 
to send via high speed internet. In the second box, you will find 
that the same photo when sent by modem will take 15 seconds. 

the amount of time to send the image seems right, then click OK.   If 
 
Sharing your printed photos 
 
Like film cameras, you can still get your photos printed at the local camera shop or drug 
store.  Instead of removing a roll of exposed film from your camera, you take the 
memory card out and give it to the clerk at the store. Just remember which photos on 
the card you want printed.  

 
Photo kiosks    
If you want to print your photos more quickly, then you have several 
options including the use of photo kiosks which can be found in 
photo processing stores such as Ritz Camera, drug stores, etc. Bring 
the photos you want to print saved on your camera card and insert 
the card in the slot in the kiosk. Then you choose the photos you 
want to print and the print size. The cost per print varies from store to 
store and according to size. 
    

Home photo printers        
Companies who make traditional desktop printers have made photo printing more 
affordable and popular by creating these fun and fast photo printers you can either 
connect to your computer directly to your camera.  Some will only print on 4” x 6” photo 
paper and some print on 4”x6”, 5”x 7”, and 8.5” x 11” photo paper.  
 
The printer companies quite often make two or three models of their brand machine, 
each with a different set of options. For example, there is a basic model which prints 
either from your computer or your camera. There is an intermediate model which comes 

with its own LCD screen so you can do 
simple editing with the printer and then 
print.  
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There may also be a third model with 
has even more options such as a 
battery or a cord to hook it up to your 
car cigarette lighter outlet to make the 
machine portable. This third version is 
sometimes referred to as the party 



model because you can take photos of your party and make prints for your guest before 
they leave. 
 
There are two types of photo printers – inkjet printers and dye sublimation printers. An 
inkjet printer is the type commonly used for general printing purposes. It uses toner 
stored in cartridges and it spreads the toner on paper in the form of dots. Photo quality 
inkjet printers can produce a photo of archival quality on photo paper. It is also perfectly 
capable of printing text. 
 
A dye sublimation printer spreads ink on paper from long rolls of heated, colored plastic 
ribbons. The resulting photos are typically look as good as commercially produced 
photos and have a smudge-proof surface. Epson has a high definition printer which is 
uses the dye sublimation process. They claim their prints to be water proof which is 
great if you like prints to show friends and wants them to be able to withstand being 
handled and possibly getting wet.  
 
Most home photo printers range in price from $80 to $200. You should compare the 
cost of each print too before making your purchase. The price of supplies varies from 
company to company. 
 

The Epson Picturemate (left) is known as a party printer. It has the 
option of using a special battery so you can take it anywhere and print 
photos for your friends and family as soon as you take them. It is light 
weight and has a convenient handle. 
  
Kodak has their EASYSHARE system which 
makes printing at home very easy. A number 
of their cameras have EASYSHARE 

capability so you can put the camera on a dock on top of the 
printer, choose the photos you want to print and watch each of 
them be printed in 60 to 90 seconds. This line of printer will 
print only on 4” x 6” sheet but you have printing options of 
creating four different sizes of prints on a sheet. There are 
other options available such as wireless printing, red-eye 
reduction, automatic color correction, and the ability to print 
with or without a computer.  
 
Hint: If you are serious about printing photos at home and already own an ink jet printer 
for general use like printing web pages and letters but you want to have a dedicated 
photo printer connect to your computer as well, it is easy to do. Your computer will 
probably have an extra USB port in the back for the second printer cable. If not, you can 
buy a hub to connect to the computer and connect the printer cables to the hub. When 
you are ready to print, choose the printer you want to use in your print dialogue box.   
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I prefer the option of a photo printer connected to the computer because I sometimes 
want to crop photos before they’re printed and print photos at various sizes. My photo 



printer will take up to 8.5” x 11” paper so my printing options are wider when working 
directly from my computer. 
 
 
Paper 
 
There is a variety of photo papers available to the home photo printing public. Major 
brands are Kodak, Canon, Epson and HP.  When choosing paper, think about how you 
are going to use the photos. 
 
Types of paper: 
Uncoated paper such as plain paper you find in copying machines or for general 
printing in your printer is good for printing a web paper or a report but not for photos. 
The ink is absorbed in the paper and spreads across the surface like water being 
absorbed by a sponge. The image becomes fuzzy.  
 
Coated paper gives the ink a surface to sit on and will give you a much sharper image. 
This paper is usually 20 – 24 lb or the thickness of paper you get from a copying 
machine. If you try to print on both sides of a sheet, it will show through.  
 
There is also presentation or imaging paper which is 
great for reports. It is 35 – 45 lbs. so it’s thick enough to be 
printed on both sides and it is coated so the ink won’t 
spread. Sometimes this paper also is acid-free so if you 
want to print a something special that you want the colors to 
remain bright for a long time, then using an acid-free paper 
should be considered.  
 
Matte or non-glossy photo paper will give you a photo with a soft overall finish. The 
paper was made for photographs and is feels like the paper used by professional photo 
printing labs. Glossy paper has a shiny surface. Again, the paper ranges in weight, 
depending upon the company.  The companies may designate their papers for everyday 
photos, better quality for framed photos and premium quality for special photos you 
want to last for many years such as graduation or wedding photos. 
 
Glossy photo paper is coated photo paper with a shiny surface on one side. The back 
is generally uncoated plain paper with the company logo on it. It comes in various 
weights from about 30 to 70 lb. There are different quality levels from general for every 
day use to archival quality for wedding or graduation photos. The price varies according 
to weight and quality.   
 
Specialty papers: 
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Greeting card paper is a heavy weight paper that is folded so you can make your own 
greeting cards using your photos. A template for greeting cards may be available in one 
of your software packages or you can pick up a separate piece of software designed 
specifically for making your own cards. 



 
Transfer paper is an iron-on transfer sheet for putting images on t-shirts or other 
clothing or fabric items.  Be sure to reverse the image or use special t-shirt transfer 
software to create your file before sending it to the printer.  
 
Fabric sheets are fine fiber sheets that have been stiffened and treated so that they 
can go through a printer and accept the toner or ink without bleeding. They are a 
wonderful craft resource for people who quilt or do cross-stitch. 
 
 
Paper Sizes 
Photo paper comes in many sizes including 4” x 6”, 5” x 7”, and 8.5” x 11”.  The 4” x 6” 
and 8.5” x 11” sheets tend to come in both small packages of about 20 sheets and also 
a larger, more economical package of 50 to 100 sheets.  
 
There are some photo printers that only print 4” x 6” paper which 
give you the option of buying a kit with both paper and toner. 
This is because the toner package using will print only the 
number of sheets in the kit so the company is trying to make it 
easier for their consumers to pick up everything they need in one 
package. The cost is usually less too.  
 
Hint:  When printing photos, remember to tell your printer what kind of paper you are 

using. You will find this option in your printer 
dialogue box when you are preparing to print. 
Sometimes printers will even give you the option of 
choosing the brand of the paper you are using. 
Doing this will allow you to choose the quality of the 
paper and telling the printer how much ink to put on 
the paper so your photo won’t be covered with a 
puddle of ink.  

 
 

 
 

Creative things to do using photoshop elements 
 
Adding text to a photo 
 
If you want to make a flier, card or simply add to a photo by putting text on top of the 
photo, here is how you do it using Photoshop Elements.  
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• Choose the Type Tool in your tool box. When you click on this 
tool, it will give you the option of a horizontal or vertical type 
tool.  



 
 
 

• The Type Options bar will appear on your screen. 
Select the font you want to use. Beside 
each font name is an example. 
 
 

• Now chose the style of type (regular, bold, etc.) 
size, and color. 
 
 
 

• Place your Type Tool in the area of 
your photo where you want 
the put the type. Drag the 
curser across the photo like 
you do for cropping to create 
a type box.   
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• To move the text box either before or after 
putting in your text, choose the Move Tool 
at the top of the tool box. Now you can 
either move or change the size of the box.  
 
 
 
 
 



 
 

It is important to note that when you create a type box, you are also creating a layer that 
floats above your photo.  On the lower right side of your screen, your will find a Layers 
window. There you will see your photo and the type layers both listed and shown. If you 
want to work on your photo, simply click on the photo. To make changes to the text box, 
click on the photo layer in the layers box and your text box will become accessible. 
 

• Click the commit button in the type options box (check mark). 
 

• Save the file with a new name so you can remember which file has the type. 
 
 

 
Talk bubbles  
 
One of the interesting things you can do with your photos using Photoshop Elements is 
to place a Talk Bubble in a photo at add some commentary. It takes several steps but 
it’s easy to do. 
 

• First chose the Custom Shape Tool near the bottom of the tool box. 
When you select this tool, a number of shapes including the talk bubble 
will appear. You may choose the bubble here or in the toolbar at the top of your 
screen.  
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• Next, in the color selection box in the tool bar choose the color your want the 
bubble to be filled with.  

 

 
 

• Move your curser to the area in your photo where you want to place the bubble. 
Drag your curser across the area like you do when cropping. You can make the 
bubble as large or small as you want. Release your mouse button. Now you can 
move the bubble with the Move Tool and make it larger or smaller if you want.  
 

Notice that while creating this shape you 
have added a layer to your photo. The 
bubble actually is in a layer above the photo. 
 
 

• Choose your Type Tool and create a 
type box inside the talk bubble.  Again 
your have created a new layer. Make 
sure to select that layer if you decide 
to change the type.  

 
 
    

 
 
Here you can see the two 
layers and the photo in the 
layers box in the lower 
right corner of the screen. 
When you save this file, 
the three layers will come 
together or flatten to form 
one layer. 
 
 
SNAP Hint:  Remember to 
save the photo with a new 
name so you still have the 
original and can easily find 
the new file with the 
bubble! 
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Touching up a photo (clone tool) 



 
One of the advantages of knowing how to use Photoshop Elements is the ability to 
touch up photos. You can eliminate blemishes and objects that are distracting or add 
objects from the same or other photos. An easy way to do this is to use the Clone tool.  

With it you can copy or clone color and pattern from 
another part of your image onto the part you want to 
change.  

 
The Clone tool has two options: the clone stamp tool and the pattern stamp tool. We 
want to use the clone stamp.  

 
The Options bar for the clone tool is now at the top of your screen. This stamp or brush 
can be defined by choosing the size of the brush stroke according to the width 
measured in pixels and the type of brush (hard or soft edges). In the example below, the 
brush stroke chosen has a soft edge.  
 
Another option is the opacity. You can overlay the pattern using 100% of the color and 
pattern you care cloning or turn down the opacity and make a soft, see through pattern 
on top of your original image. 
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When you clone, you chose an area of your picture from which to clone. If you want 
your clone brush to duplicate an area next to your curser, then click o the alignment 
box. If the box is not selected, then you will only clone from a single area you choose.  
 

 
 
 
To clone, move your curser to an area you want to 
clone from. Press the Alt button and right click at 
the same time. A + will appear in that area. Your 
curser, which is now a circle, will clone when you 
press down on the mouse button. Drag your curser 
across the area you want to change. If you are 
unhappy with the result, then press the back button 
on your tool bar or go to Edit > Undo clone stamp 
to go back one step. 
 
 
 

 
Another option is the Healing Brush tool.  It is a good tool for fixing large areas 
such as a background (sky, grass, etc). It does not have sharp edges like the 

clone stamp.  
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After you clone the area you are fixing with the 
healing brush and release the mouse button, the 
computer will blend the edges of the area you 
brought the pixels into with the new pixels. Now   
the branch is no longer going through our 
friend’s head. This smoothing process can save 
you a lot of time so you don’t have manually fix 
each partially cloned flower and leaf. It looks like 
you would expect it to. 

 
 

Turn your photo into a 
piece of art  

 
Photoshop Elements gives you many quick and easy options for turning your 
photographs into unique digital images, sometimes no longer resembling photographs 
but looking much more like pieces of art! You can make a photo look like a watercolor 
painting, a stained glass window, a charcoal drawing, a mosaic and many other styles 
of two and three dimensional art. You can also combine styles using one filter after 
another to create unusual color and texture. 
 
 
 
 
 
 
 
The process is simple and a 
lot of fun. Find a photo on 
your hard drive that has 
good contrast. Pick 
something simple or crop an 
image, choosing an area 
that will be able to accept 
details like mosaic tiles or 
cross-hatching filters. 
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Filters and the Filter Gallery 
 
You can access Photoshop Element’s filters two ways. You can go to the 
Filters on the menu bar and select the filters you want to use on your photo 
from the drop down menu. There are filter styles which are listed on the 
right in the illustration. Each style has several options from which to 
choose. 
 
At this place, you also have the option to choose the Filter Gallery. If you 
are trying out filters for the first time, then I would suggest using the Filter 
gallery because you can see examples or thumbnails of the filters before 
you choose one. 
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In the Filter gallery window, you have a number of options for working with your 
image. First of all, the image you are working on appears in the preview screen on the 
left. You can make the preview larger or smaller with either the + or – buttons in the 
lower left corner or use the drop down menu next to the button to choose the size of the 
image by percentage. Just like the regular view an image in Elements, if the image is 



larger than the screen, scroll bars will appear on the bottom and right side of the screen 
so you can change your view.   
 
In the center of the window, you have thumbnails of examples of the filters. The filters 
are divided into styles here too. Select a filter by clicking on the thumbnail. The preview 
of your image will appear with the filter added. The filter can be adjusted using options 
on the right side of the screen.  
 
In the example above, the Colored Pencil filter has been chosen. The options for 
adjusting this filter are pencil width, stroke pressure and paper brightness. Using the 
slides to adjust the amount of each change, you will see the difference in the preview. 
When you are happy with the effect you get with the filter, then click OK. If you don’t 
like the first filter you choose, then go on to a different one and see how it changes your 
image. 
 
The next example was created using the Accented Edges filter. It is chosen in the 

same way as the example above but it has different 
adjustments.  
 
You can adjust the Edge Width by choosing a number 
between 1 and 14, with 14 being the widest.  
 
Next you can adjust the Edge Brightness by choosing a 
number between 0 and 50 with 50 giving you the brightest 
edges.  
 
The last adjustment is for Smoothness. You can adjust 
from 1 to 15 with 15 giving you the smoothest edges.  
 
 
  
 

   Accented edges      
 
One more example of a filter is Neon Glow.  This 
filter turns your image into a black and white 
image but white can be changed to other colors.  
 
In adjustments for this filter, you can 
choose the Glow Size or how much glow you 
want. The choice ranges from -24 to +24. 
 
The next adjustment is for Glow Brightness. 
The color brightness ranges from 0 to 50. 

Neonglow 
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You can choose the color you want to glow by using a color picker.  



• Double click on the box marked Color Glow which is below the adjustment 
slides.  

• A color picker box will appear. In this box you will find a long rectangular box 
containing the color spectrum. When you slide the arrows up or down on either 
side of this box, the color in the square on the left will change. When you have 
found the color you like, you can make more adjustments to the tint by running 
your curser over the large box. It will now be a small circle. Wherever you click 
with your curser, the color you clicked on will appear in the top box in the upper 
right corner of the color picker window.   

• When you have the right color and tint selected, click OK. Now the preview will 
appear with the new color in a glow.  
 

 
 
If you would like to add texture to your photo, you might like to try the Stained Glass 
filter. It will break your image into small pieces with lead lines in between. You will find 
this filter in the filter gallery in the folder called Texture along with 

• Craquetone 
• grain  
• mosaic tiles 
• patchwork and  
• texurizer  
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You may adjust the filter in the following ways: 
• Cell size may be adjusted from 2 (smallest) to 49 (a very large cell which may 

make your image unrecognizable) 
• Border thickness may be adjusted from 1 (a very thin line) to 20 (which fills in 

the image with border) 
• Light intensity adjusts from 0 to 10. 

 
 
 
 
 
 
 
Books and magazines available at the Library 
 
An Illustrated A To Z Of Digital Photography by Neigel Atherton & Steve Crab 
I Just Bought a Digital Camera, Now What?!  by Dave Johnson. 
How To Do Everything With Your Digital Camera by Dave Johnson. 
Digital Photography 1, 2, 3: Taking and Printing Great Pictures by Rob Sheppard. 
The Joy of Digital Photography by Jeff Wignall. 
Digital Photography: An Introduction by Tom Ang. 
Step-By-Step Digital Photography: A Guide for Beginners by Jack & Sue Drafahl  
A  n Illustrated A to Z of Digital Photography by Nigel Atherton and Steve Crabb 
 
PCphoto  
Popular Photography and Imaging   
Digital Photographer   
 

 
Digital Photography web sites 

 
www.dpreview.com
www.steves-digicams.com
www.digitalcamerainfo.com
www.livingroom.org.au
www.digitalcamerareview.com
 
 
2/14/07 
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http://www.aadl.org/cat/seek/?ue=search%2FXphotography%26searchscope%3D4%26m%3Ds%26SORT%3DD%26topformsub%3D1%2FXphotography%26searchscope%3D4%26m%3Ds%26SORT%3DD%26topformsub%3D1%2F1%252C5%252C5%252CB%2Fframeset%26FF%3DXphotography%26searchscope%3D4%26m%3Ds%26SORT%3DD%26topformsub%3D1%262%252C2%252C
http://www.aadl.org/cat/seek/?ue=search%2FXphotography%26searchscope%3D4%26m%3Ds%26SORT%3DD%26topformsub%3D1%2FXphotography%26searchscope%3D4%26m%3Ds%26SORT%3DD%26topformsub%3D1%2F1%252C5%252C5%252CB%2Fframeset%26FF%3DXphotography%26searchscope%3D4%26m%3Ds%26SORT%3DD%26topformsub%3D1%265%252C5%252C
http://www.dpreview.com/
http://www.steves-digicams.com/
http://www.digitalcamerainfo.com/
http://www.livingroom.org.au/
http://www.digitalcamerareview.com/
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